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Advanced Design System 2021 Update 1.0 Release Notes
For general information about Advanced Design System (ADS), visit ADS webpage at http://
www.keysight.com/find/eesof-ads. 

Starting ADS 2020 release, the Linux system requirements have been updated:

Support for Redhat 5.x has been discontinued.
Updated the system libraries and rpm files. Following is the list of minimum patch versions 
required:

Redhat 6.10
Redhat 7.2
Suse 12.2
Suse 11.4

Few ADS features will not work properly, in case you have installed lower patch versions than the 
above-recommended versions.  

For more information, refer to Supported Platforms.

Contents

Feature Updates
Known Issues

Feature Updates
Design and Technology Management
Design Editing
Data Display
Circuit Simulation
HSD Design
EM Simulation
Power Electronics
Verification
Virtual Test Bench (VTB)
Licensing

Design and Technology Management
Restored ability to set window size and position.
Enhanced Copy Cell to allow overwriting/replacing referenced data files.
Enhanced Manage Libraries lib.def editing to retain but notate, in lieu of removing, invalid libraries.
Improved Reference performance by caching reference information to disk.

Known Issues

  Back to Feature Updates

http://www.keysight.com/find/eesof-ads
http://www.keysight.com/find/eesof-ads
http://edadocs.software.keysight.com/display/support/ADS%20Supported%20Platforms
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Design Editing
Supported full-blown polygon editing in the Properties docking window.
Enhanced the Keepout object to support the avoidance routing. For more information, see Creating 
Keepout.
Added ability to specify any substrate file as the master substrate. For more information, see Master 
Substrate.
Enhanced symbol related creation or editing commands to support orientation of instance-based pins
Enhanced Create Pin interface to support creation of area pins from existing shapes
Added a new preference to disallow connecting a pin to ground in schematic. For more information, 
see Overview of Schematic IC Interoperability
The support for the following capabilities is frozen with the previous ADS 2021 release:

Import/Export of Mentor Boardstation PCB Link files
Dynamic Access for Mentor Design Kit.

Known Issues

  Back to Feature Updates

Data Display
Added Drag and Drop support from Expression Manager to DDS page.
Added Equation Insert in Expression Manager.
Better organized font selection menu that also includes the Most Recent Fonts anew.
Supported indexing a swept variable using another variable as the index  
Improved error reporting in AEL expressions and ADX translation.
Added a menu option to select all traces in selected plots.  

  Back to Feature Updates

Circuit Simulation
General

Implemented HiCUM L0 Version 2.0.
Implemented BSIM-IMG 102.9.4.
Implemented JFET100 Version 0.51.
Speed improvements when parsing large PDK models.
Bug fixing:

Expressions as Laplace source coefficients are now correctly handled in non-ADS netlist.
Fixed the issue where Grid Engine does not really support user group, removed it from menus.
Implemented support for .nodeset for spice netlist.
VTB now creates *.ds file in data folder along with *.adx file.
Fixed the floating point exception in juncap 2 diode model.

ElectroThermal

https://edadocs.software.keysight.com/display/ads2021update1/Creating+Keepout
https://edadocs.software.keysight.com/display/ads2021update1/Creating+Keepout
https://edadocs.software.keysight.com/display/ads2021update1/Master+Substrate
https://edadocs.software.keysight.com/display/ads2021update1/Master+Substrate
https://edadocs.software.keysight.com/display/ads2021update1/Overview+of+Schematic+IC+Interoperability#OverviewofSchematicICInteroperability-grdPinSymbol
https://edadocs.software.keysight.com/display/ads2021update1/Expression+Manager
https://edadocs.software.keysight.com/display/ads2021update1/HICUM+Level+0+Version+2.00
https://edadocs.software.keysight.com/display/ads2021update1/BSIM-IMG+Version+102
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Added "Skip storing each sweep point GDA file" option to avoid create of .gda files and save disk 
space after performing a sweep simulation.
Added Error/Warning for duplicate power sources.
Ability to avoid .gda file creation to save disk space.

Known Issues

  Back to Feature Updates

HSD Design
SerDes

Provides improved Channel Sim solution with support for multiple Tx/Rx, also known as multi-lane 
support (such as PCIe).
Provides Channel Sim solution for PAM3, PAM8, and PAM16 for Automotive Ethernet and MIPI A-
PHY.
Enabled FlexDCA probe to access directly from a sub-circuit based net names and net names.
Simulation status window (log) now includes status about connecting to Infiniium/FlexDCA 
software.

DDR/Memory
New LPDDR5 solution that supports WCK and RDQS new signal types and single-ended clock.
Improved BatchSim setup, that displays detailed information such as Parameter name and Signal 
name(s).
Improved usability for DDR_Term component.
Improved usability for DDR_PCB component handling SIPro cells.
Improved usability for handling CSV files.

EM-SIPro/PIPro
CILD: Goal value of Zc diff and Zc common values now set automatically to default.
Capture load time of layout rendering while opening XXPro Setup.
Switching VRM port editor add-on.
Fixed the issue where simulation becomes unstable if port length is too long.
Added support for reference pins in SIPro/PIPro.
PIPro Sink Editor now supports the use of a lumped R-L-C or an S-parameter defined package 
model.

Known Issues

  Back to Feature Updates

EM Simulation
RFPro

Analyze the impact of conductor conductivity and dielectric permittivity material bias. For more 
information, see the Process Variation section in Full EM Extraction Analysis.
Components that are made invisible are now grayed out in the design tree to show this state.
The FEM simulation bounding box is no longer shown in the Geometry window. Its actual 
dimensions are only known during the simulation.

https://edadocs.software.keysight.com/display/ads2021update1/Description+of+Channel+Simulation
https://edadocs.software.keysight.com/display/ads2021update1/PAM+AMI+Simulation
https://edadocs.software.keysight.com/display/ads2021update1/Full+EM+Extraction+Analysis
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The cds.lib parser now expands variables recursively.
Duplicating a user-defined analysis now duplicates the frequency plan.
Upgraded the HOOPS Visualize library to version 2410.

Momentum
Faster Green function computation.

FEM
Addressed an issue where a FEM simulation could fail while writing huge data files.

BroadBand Spice Model Generator
Fixed a model generation issue when a .sio format file was used as input.

LTD Substrate Editor
TSMC N3 iRCX files can now be successfully imported.

Known Issues

  Back to Feature Updates

Power Electronics
Power Electronics Professional (PEPro)

This list of improvements to Broadband SPICE Model Generator (BBSMG) are mainly aimed at 
PEPro users, but they are available to all ADS users because BBSMG is licensed in ADS Core

Added a new option to export PSpice compatible model. For more information, refer Creating 
Broadband SPICE Models.
Added instructions and best practices for creating a PSpice compatible model. For more information, 
refer Exporting a SPICE Compatible Model
Added an indicator for reading large input files when using Advanced Input Options.
Fixed a bug in the stop simulation functionality.
Fixed a crash error when enforcing passivity without enabling global poles.
Fixed a bug in the data display template.

Design Import/Export

Added support for LTspice compatible "vswitch" element in the Netlist Importer.

Known Issues

  Back to Feature Updates

Verification
PVS DRC Link

Cadence PVS (Physical Verification System) DRC is now available as an option when running DRC 
from ADS Layout.
In the DRC Dialog, see the Options tab. For more information, see Using PVS DRC Link.

https://edadocs.software.keysight.com/display/ads2021update1/Creating+Broadband+SPICE+Models
https://edadocs.software.keysight.com/display/ads2021update1/Creating+Broadband+SPICE+Models
https://edadocs.software.keysight.com/display/ads2021update1/Exporting+a+SPICE+Compatible+Model
https://edadocs.software.keysight.com/display/ads2021update1/Using+PVS+DRC+Link
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For Batch DRC, see AEL functions for configuring and running a DRC job.
For configuring PVS DRC in a PDK, see AEL functions for library configuration. For more information, 
see DRC Library Configuration.

Auto Center for DRC, LVS and LVL

Auto Center option centers the highlighted error without changing the zoom factor.
Auto Center is available for DRC (Design Rule Check), LVS (Layout versus Schematic) and LVL (Layout 
versus Layout).

Assura DRC Link

Increased the maximum number of errors from the Assura system default. The number of errors was 
previously limited to 1000.

DRC Links

Run mode setting (Local, Remote) is now saved with the other job settings.

  Back to Feature Updates

Virtual Test Bench (VTB)

From ADS 2021:
Verification Test Bench (VTB) is now called Virtual Test Bench (VTB).
To install files that are required for the VTB functionality along with the ADS installer, you need to 
download a separate VTB installer for both Windows and Linux and manually install the VTB.
If you have already installed ADS and find VTB functionality is missing, then you need to download 
and manually install the VTB.
If you want to uninstall, then you need to manually uninstall VTB separately for both Windows and 
Linux.

 

For more information, see VTB documentation.

Known Issues

  Back to Feature Updates

Licensing
ADS requires: a) the version 2020.02 of the EEsof EDA licensing software, b) a minimum code-word 
version 2020.02 or above, and c) the licensing server software, lmgrd and agileesofd, to be upgraded 
to at least the same versions as what are included in EEsof EDA Licensing software 2020.02  ADS will 
not start if any of these requirements is not met. Refer to the License Codeword Version Compatibility
Table.
In the EEsof EDA License Tools version 2020.02, licensing vendor daemon (agileesofd) is integrated 
with FlexNet FNP 11.16.5.1 version (Windows) and FlexNet FNP 11.16.5.1 version (Linux) of FlexNet 
license manager daemon (lmgrd). For the Windows platform, ADS installer will automatically set up 

https://edadocs.software.keysight.com/display/ads2021update1/Batch+DRC
https://edadocs.software.keysight.com/display/ads2021update1/DRC+Library+Configuration
https://edadocs.software.keysight.com/display/ads2021update1/Virtual+Test+Bench
https://edadocs.software.keysight.com/display/ads2021update1/License+Codeword+Version+Compatibility
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these two new license server daemons by default for the local node-locked license users; for the Linux 
platform, you need to follow the Setting Up Licenses on Linux instruction to complete the licensing 
configuration process. For more details, refer to Licensing (For Administrators).

Known Issues

  Back to Feature Updates

Known Issues

Design and Technology Management
Using ADS 2020 with pycell studio 2018 (PyCell Studio Packages: Release O-2018.09) might prompt 
you an OA version mismatch warning message on the linux terminal. However, there is no impact on 
the iPDK flow in ADS.
Linux terminal message:
Requested minor API version '518', which is supported by OpenAccess build '22.50.030' is newer than 
the minor API version '514' of the shared library of OpenAccess build '22.50.043'.
The Express Pcell plugin that comes with Virtuoso IC version 6.1.8 does not work with ADS 2020 due 
to an OpenAccess version mismatch, but the Express Pcell plugin will work with ADS 2020 Update 1.0 
and 2.0.  
Workarounds: 

When running ADS 2020, set the LD_LIBRARY_PATH environment variable path to point to the 
directory from IC version 6.1.7.
Upgrade to ADS 2020 Update 1.0

The Express Pcell plugin that comes with older versions of Virtuoso IC version 6.1.7 may crash during 
a simulation with ADS 2020 Update 2.0 due to a third party incompatibility but may work with newer 
versions above IC version 6.17_722 and up.
AEL constants are protected and should not be modified in any DDS expressions.  An AEL error will be 
issued in case an attempt to modify an AEL constant occurs.
Python Datalink

When using Connection Expert 2019 connected to Lan Instruments, there may be error messages 
during dl_visa_query() and dl_visa_write().
Exceed on Demand: Note that in some cases, EoD settings may need to be configured to properly 
display Spyder.  Please contact your EoD support representative for additional guidance.

  Back to Feature Updates

Design Editing
Designs created using Smart Mount for Multi-Technology feature cannot be used to run an 
electrothermal simulation.

  Back to Feature Updates

https://edadocs.software.keysight.com/display/ads2021update1/Setting+Up+Licenses+on+Linux
https://edadocs.software.keysight.com/pages/viewpage.action?pageId=607055365
https://edadocs.software.keysight.com/display/ads2021update1/Introduction+to+AEL
https://edadocs.software.keysight.com/display/ads2021update1/Smart+Mount+for+Multi-Technology
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Design Guide
Unable to unarchive HDMI design guide from the Schematic view (DesignGuide > HDMI).
Workarounds:

Unarchvie using the old ADS version.
HDMI design guide will open in case it is already unarchived.

Simulating the "1_Sim_CA" design in the DDR4 CTB design guide prompts the netlist error.
Workaround: Open the schematic design "PatternGen_CA_Continuous" and arrange the pin numbers 
in order.
Simulating of schematics in the HDMI_Link_Simulation design guide prompt the netlist error.
Workaround: Open the schematic design “HDMI_Diff_RX” and arrange the pin numbers order in order.

Design Kits
A design created using ADS2020 Non-Linear Demo Kit (NLD) and using NLD discontinuities like 
demo_bendP, demo_stepP, demo_teeP, etc. will not work as expected in ADS 2021.
Workaround – In ADS 2021, either update the design with the latest NLD i.e. NLD shipped along with 
ADS 2021; or continue to use the NLD that was shipped with ADS 2020.

  Back to Feature Updates

Circuit Simulation
General

When using GoldenGate in ADS 2020 Update 2.0, some of the library files of RFIC cockpit options 
are not getting loaded due to license incompatibility. It is recommended to use ADS 2020 Update 1 
when using GoldenGate in ADS. 
For details on license compatibility, see License Codeword Version Compatibility.
Simulation Manager may not work on Windows and throw exceptions for some designs.
ADS 2019 will not be compatible with Verilog-A files, which have been encrypted before ADS 2019. 
There is no change for non-encrypted Verilog-A files.
TMI models are supported for pure Hspice syntax only. The support of hybrid syntax (mixing 
Hspice and Spectre) is planned for a future release. 
BSIMSOI models using TMI modeling is not supported yet. Classical BSIMSOI models are 
supported as before.
TMI Aging simulations are not supported 

ElectroThermal
In ADS, electro thermal simulation is assisted to automatically turn off the HBAHB and TAHB 
options for single tone HB. However, the electro thermal simulation for multi-tone HB needs a 
manual intervention to turn off the HBAHB and TAHB options for reporting voltage data.
You may not be able to start a Transient/Envelope Electro-Thermal (ETH) simulation only when the 
same testbench is open in the viewer of Transient/Envelope thermal results. You need to close the 
viewer before launching a Transient/Envelope ETH simulation.
The electrothermal simulation will not run on designs created using Smart Mount for Multi-
Technology feature.

http://edadocs.software.keysight.com/display/support/License Version Compatibility
https://edadocs.software.keysight.com/display/ads2021update1/Smart+Mount+for+Multi-Technology
https://edadocs.software.keysight.com/display/ads2021update1/Smart+Mount+for+Multi-Technology
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Paths set while configuring the ETH controller may need to be updated when the workspace is 
moved across operating systems.
On a fresh Linux machine, electrothermal simulation fails with the following error message:
Heatwave returned an unknown error code 127.
Workaround: The error could be due to missing packages, for example, libpng12. Verify your 
system meets the requirements using the linux_sys_check.sh script. For more information,  
see Checking Installed RPM Files and the Operating System Version.
If you get licensing errors while running thermal simulation, you may need the following 
workaround.
Workaround: Rename the file  $HOME/.eesofrc. For example,  $HOME/.eesofrc-orig.
Electrothermal does not support remote simulation, batch simulation, Monte Carlo, tuning, 
Optimization, and Measurement Equations. Also, you cannot sweep directly on the DC controller.
All libraries referenced in a layout should use the same layout resolution, namely the OA database 
units (DBU) per user unit (UU).
You cannot run both a transient and envelope simulation on the same design from one testbench.
The calculation of power dissipation from passive components other than resistors may not be 
correct in harmonic balance simulations.
Electrothermal does not support the transient or envelope simulation that is controlled by a 
ParamSweep.  
If you get "Maximum timestep reduced to half of shortest transmission line delay " warning, it can 
lead to transient simulation to not converge   
Workaround: Unselect "Limit timestep for Transmission Line" option on Time Setup tab of Tran 
component to get it work.
On Linux, if you specify the THERMAL_DIRECTORY variable in eesof_lib.cfg file using backward 
slash (..\thermal), the thermal simulation does not run properly.
Workaround: Specify the THERMAL_DIRECTORY variable using forward slash (../thermal) instead 
of backward slash.
The ETH viewer does not support 4K displays. A few instances of text and icons may appear 
distorted. 
You receive an error message in substrate editor that you cannot use the same layer number more 
than once. You can safely ignore this error during thermal technology export.
On a fresh Windows 10 system, Electrothermal simulation terminates with an error. 
Workaround: Install the following Microsoft Visual C++ runtime components: 
http://www.microsoft.com/en-in/download/details.aspx?id=30679  
https://www.microsoft.com/en-in/download/details.aspx?id=5555

DDR Design 
You receive an error message to check port numbering when performing simulation with SnP 
component for differential configuration.
Workaround: Select the first option in Pin Configuration for the SnP component.

  Back to Feature Updates  

https://edadocs.software.keysight.com/display/ads2021update1/ADS+Supported+Platforms+on+Linux#ADSSupportedPlatformsonLinux-1114455
http://www.microsoft.com/en-in/download/details.aspx?id=30679
http://www.microsoft.com/en-in/download/details.aspx?id=5555
http://www.microsoft.com/en-in/download/details.aspx?id=5555
http://www.microsoft.com/en-in/download/details.aspx?id=5555
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HSD Design
SerDes

You receive an error message when runtime libraries for some of the ADS example ibs files (for old 
AMI models) are unable to get installed automatically during the ADS install.  The error appears 
eventhough the ibs file is supported on specific platform. 
Workaround: Microsoft Visual C++ 2010 runtime library is required to run the dll files. Download 
the following library if it is not installed:
https://www.microsoft.com/en-us/download/details.aspx?id=14632

EM-SI/EM-PI
SIPro/PIPro, Via Designer 

On Windows 10 with Intel HD graphics, Via Designer may show an error message ‘Failed to use 
the connection between ADS and Via Designer.’  This has been isolated to the latest release of 
Intel HD Graphics drivers (23.xx.xx.xxxx).
Workaround: Downgrading graphics driver to the previous recommended driver resolves this 
issue (e.g., 22.20.16.4836, A05).
DirectX 9 as graphics driver is no longer supported. DirectX 11 is thus be used by default. Run 
"diagdx" to verify which DirectX version is supported on your system.

SIPro/PIPro
ADS 2020 is not compatible with the latest available Samsung component models released in 
June 2018. The support for the component models is planned to be added in an upcoming 
update release.
Simulation failure when using components with S-parameter models or for which the model is 
defined using a lib/cel/view in case the Updating model does not require new simulation is not 
set. As a workaround, turn on the option. For PI-AC simulations, the options are turned on by 
default, for SIPro, this needs to be turned on explicitly.
If you run SIPro/PIPro on a fresh machine with Suse 11 or Redhat 6 installed, you may 
encounter the critical error "EMPro exited unexpectedly during execution." This is related to the 
graphics driver software.
Workaround: Upgrade to the latest vendor-specific drivers and OpenGL libraries for the graphics 
card. 
Alternative workaround: Run the following commands:

cd $HPEESOF_DIR/fem/2020.20/linux_x86_64/bin
./startempro --personality=sipi--driver=x11

Ignore any license related error messages that may show up on executing these 
commands. The driver setting is saved per personality for future sessions.
With split domains on, there are no results available until simulation results are available from 
the last simulation, or even after the simulation.

PIPro-DC
The power graph is not correct when VRM's or Sinks are defined, starting from pin definitions. 
All the other result data is correct. This issue does not occur when VRMs and sinks are defined 
from component instances.

  Back to Feature Updates

https://www.microsoft.com/en-us/download/details.aspx?id=14632
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EM Simulation
RFPro

The FEM and Momentum Generation 2 flows are state-of-the-art solvers but still evolving. In case it 
does not handle your design, switch back to Generation 1.
Multi-technology designs cannot be analyzed with Momentum.
Workaround: Use the FEM simulator
Project load fails with the error 'OccDesign::getNet: key not found' when a layout shape has a multi-
bit net name (e.g. 'd<7:0>' or 'a,c,net1').
There is no workaround.
With McAfee Endpoint Security (ENS) enabled, the Momentum surface current visualization hangs.
Workaround: Disable the "Enable Adaptive Threat Protection" flag in McAfee ENS.

RFPro and 3D Viewer
If you run the tool on a fresh machine with Suse 11 or Redhat 6 installed, you may encounter the 
critical error "EMPro exited unexpectedly during execution." This is related to the graphics driver 
software.
Recommended workaround: Upgrade to the latest vendor-specific drivers and OpenGL libraries for 
the graphics card.
Alternative workaround 1: On Linux, launch the tool and force it to use the X11 driver. On Windows, 
set the driver to 'msw'. This preference is saved for the current user and per personality. You can 
do that by executing following commands, e.g. in a shell on Linux:

cd $HPEESOF_DIR/fem/2021.10/linux_x86_64/bin
./startempro --personality=rfpro --driver=x11
./startempro --personality=3dview --driver=x11

Ignore any license related error messages that may show up on executing these commands. The 
driver setting is saved per personality for future sessions.
Alternative workaround 2: Set following environment 
variable EMPRO_SET_SOFTWARE_DRIVER_AS_DEFAULT=1. This variable controls the default 
driver when no preference was set. On Linux, X11 is used. On Windows, MSW is used.
You can clear all preferences as follows:

cd $HPEESOF_DIR/fem/2021.10/linux_x86_64/bin
./startempro --personality=rfpro --clear-preferences
./startempro --personality=3dview --clear-preferences

EM Setup
On a Virtual Windows 10 system with Microsoft Hyper-V Video display driver, the 3D EM Preview 
with EM Setup Preprocessing may bring up a dialog with a Hoops error, and, after suppressing the 
dialog, it opens up blank. 
There is no workaround.

Distributed simulations
The example implementation of the sitecluster command for LSF clusters may lead to failing 
simulations if the path or number of threads is too large.
Workaround: See the workaround details in the sitecluster documentation.

https://edadocs.software.keysight.com/display/ads2021update1/Using+Site+Cluster
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a.
b.

c.

Import/Export
Exporting with MentorDA link does not work with the latest Mentor Graphics software Version 
VX2.6. 

  Back to Feature Updates

Power Electronics
PowerMOS_SiC power devices operate under a very wide range of voltage and current slew rates and 
it is a challenge to create a model that converges under all conditions – especially conditions that 
depend upon what components are connected externally to the power device in the circuit schematic. 
Please contact technical support if you encounter such an issue when attempting to use this model.
If you run PEPro on a new machine with Suse 11 or Redhat 6 installed, you may encounter the critical 
error "EMPro exited unexpectedly during execution." This is related to the graphics driver software.
Workaround: Upgrade to the latest vendor specific drivers and opengl libraries for the graphics card. 
Or
Run the following commands:

cd $HPEESOF_DIR/fem/2020.20/linux_x86_64/bin
./startempro --personality=sipi--driver=x11

You can ignore any license related error messages. The driver setting is saved per personality for 
future sessions.

  Back to Feature Updates

Installation
While installing a new version of ADS, if you see “Previous version detected” error even after you have 
already run the uninstaller for that version of ADS, you may need to manually uninstall ADS before 
installation of the new ADS. To manually uninstall ADS, perform the following steps.

Exit the current ADS installation session if it is running
Remove or rename the file .com.zerog.registry.xml  under the folder  C:\Program Files\Zero G 
Registry . Both the folder and the file are by default hidden, so you may need to change the folder 
viewing setting to show hidden files and folders, do so via the Advanced settings of the View tab in 
the Windows Folder Options dialog box.
Remove the ADS installation directory through the Windows Explorer.

After performing the above steps, you can re-start the ADS installer.

  Back to Feature Updates
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a.

b.
c.

Licensing
You may observe additional License Usage when Client Machine reconnects to network after 
intermittent disruption.
Workaround: In case of network interruption on the client machine, to reclaim the inactive licenses, a 
TIMEOUT can be set using the TIMEOUTALL feature in options file (minimum time period of 15 
minutes). The inactive license may stay checked out for this period of time
Unable to install Licensing Hardware Key Drivers on Windows.
Workarounds:

Turn off UEFI Secure Boot (BIOS) and use the default 6.3 version of the Wibu key driver delivered 
with the EEsof Licensing tools.
Turn on UEFI Secure Boot (BIOS), upgrade to ADS 2020 Update 2.0 and use the 6.51 WibuKey 
driver version available in the 2020.02 License tools installation directory.

You will not be able to run older ADS releases with the 6.51 WibuKey dongle drivers

You may observe issue in recognizing more than one FLEXID on Linux platform with the 2020.02 
license tools.
Workaround: Consolidate your licenses to one FLEXID and configure the same.
Setting FLEXLM_DIAGNOSTICS to the highest level (FLEXLM_DIAGNOSTICS=3) on Windows client 
may cause a crash during license checkout. Flexera is investigating this issue.
Workaround: It is recommended not to use the FLEXLM_DIAGNOSTICS on Windows clients or use it 
at lower level (FLEXLM_DIAGNOSTICS=1 or FLEXLM_DIAGNOSTICS=2).
WibuKey 6.5 software driver is not supported on SuSe 11.
Workaround: Use the older WibuKey 6.30 software driver (WkRt-Lin-6.32.1504-500.x86_64.rpm).
Licensing may not support a license file path that is too long. This will likely occur when you have too 
many license files. 
Workaround: Remove some license files, move the license files to a shorter directory path or to 
combine license files into a single file.
License Setup wizard may not be able to start license server with many license files. During setup, it 
may lead to a situation where a command prompt window appears/disappears incessantly. This is 
due to the fact that License Setup wizard is not able to start lmgrd with a long command line and may 
get stuck in a loop.
Workaround: 

It is recommended to combine all license code words tied to same MAC ID into single license file 
to avoid setting large number of license files.
Try to use a shorter path to place license files.
If #1 and/or #2 does not help, start the license server (lmgrd.exe) from the command line 
(e.g. lmgrd.exe -c <lic-file-path> -l <license_server_log.txt>) and then set 
<PRODUCT>_LICENSE_FILE=<PORT-NUMBER>@localhost for product you want to use on same 
PC.

Dongle drivers for Flex-10 dongles on Linux are release specific. Installing the latest dongle drivers on 
Linux will function properly only for the most recent EEsof releases.
Workaround: Install and use dongle drivers as needed.  If you need to run the most recent EEsof 
releases, use the latest  Flex-10 dongle driver. If you need to use older releases, uninstall the latest 
dongle driver and re-install the older dongle driver
FLO and EEsof License setup are writing server logs at different locations. However, the EEsof server 
log file location is updated in the License Manager > Environment tab.
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When multiple same-named INCREMENT lines of different version exist on the license server, few 
advanced FlexNet options to reserve/limit licenses may not work properly. 
Product Selector “Check Availability“ generates incorrect results (which leads to license failure) for 
older releases when multiple date base versions of like-named bundles exist in the license pool.
In Linux, Product Selector OK and Cancel Buttons locations are reserved.
Starting from FlexNet Publisher 2015 (also known as version 11.13.1), the adoption of the best 
practice of the least-privilege security therein results in the License Server related Windows Service to 
run with the LocalService Account privilege (instead of the LocalSystem privilege as before.)  Running 
with the LocalService Account privilege, an executable can no longer access any files located in the 
per-user specific type of folders.  As a result, any license file placed in those folders can no longer be 
accessed by the License Server when the License Server is automatically started via the Windows 
Service upon each PC reboot. For the local node-locked license, this would not result in any disruption 
to the usage of EEsof applications; however, for the license installed on a network PC that is accessed 
by multiple client PCs, this may cause EEsof applications not to start after the network PC reboots
Workaround: Store your license files in the Windows folders that are accessible by the LocalService 
Account privilege.  For example, C:\ProgramData or C:\users\public are both qualified choices.  In 
general, any folder that has the "Users" group listed in its Properties > Security page and this "Users" 
group has the read permission enabled should work. 
Using the default port to connect to a license server may cause a delay when checking out licenses. If 
no port is given in the license file, Flexera scans ports 27000 to 27009 to find the port. Starting from 
FlexNet Publisher 2015 (aka version 11.13.1), the default timeout for the response from each port 
increased from .1 seconds to 3 seconds.
To avoid the delay, KSM now issues licenses with port 27009 instead of leaving this blank. The EEsof 
License Setup Wizard (from Licensing 2017.01 onwards) handles some common situations such as: 
where it detects license file(s) without port, when users get a new license file with port 27009, or when 
all license files for a vendor daemon does not have same port.

You will not be able to start the license server if all license files for a vendor daemon on a server 
does not have same port.

Users who manually setup a license server or using EEsof License Setup Wizard with older licensing 
bits may need to manually edit license files to comply with the following rules:

All license files for a vendor daemon on a server must use the same port (or all be blank). 
Using the default port (blank) is allowed but may result in longer checkout times. 
If setting up a network server, select an unused port that is not blocked by a firewall.

Workaround: If the user cannot change the port, or wants to use the default Flexera ports, the 
environment variable FLEXLM_TIMEOUT can be set to .2 seconds (200000), to minimize the 
performance degradation. However, if the network latency is an issue in your environment, you may 
need to fine-tune this setting to minimize the general performance degradation while still 
accommodating the network latency.

Installation of EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) may 
hang at 4% (percentage vary based on the products) for few hours or even more on some specific 
machines.
Workarounds:

Disable Firewall setting in Anti-Virus Software installed on the PC.
or
Download and unzip process explorer from the below link and then invoke procexp.exe.
https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
Right click on the wusa.exe process under <Product installer exe> and select KillProcess. Now it 
will continue the product installation.

https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
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After installing EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) 
successfully and try to invoke the software or License wizard, you may encounter “api-ms-win-crt-
runtime-l1-1-0.dll” missing error.
Workaround: Install the Update for Universal C Runtime in Windows .  On Windows 64-bit system 
systems, the file to install is x64 version of the Microsoft hotfix KB2999226. A copy of 
the Windows6.1-KB2999226-x64.msu Microsoft 64-bit hotfix installer can be found under the C:
\Program Files\Keysight\EEsof_License_Tools\bin directory.  The Microsoft hotfix KB2999226 
can be found under the Update for Universal C Runtime in Windows  page at  https://
support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows as well.
On a newly formatted RHEL system, the EEsof Licensing tools may fail to boot. This is because the 
FlexNet Publisher 2015 requires a certain rpm
Workaround: Under the EEsof product installation directory, there exists a utility script named "Linux_s
ys_check.sh" under the bin directory. Run this script to find out whether any rpm is missing; run this 
script with a "-y" command-line option to also have all the missing rpms automatically installed if you 
have the sudo or root privilege.
License server may stop recognizing Flex-10 dongle on some systems within a few hours after 
starting 
Workaround: If v6.10 or v6.11 is found and experience this problem then upgrade the WibuKey 
drivers to v6.30/6.30b from Wibu Systems.
Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a machine
Workaround: Before installing a Flex-10 driver for the first time, unplug the Flex-9 dongle.
There is a known FlexNet Publisher issue, whereby mixing node-locked codewords and floating 
codewords in one license file can result in: a) Remote simulations not working or b) A second local 
simulation not working in case the license is node-locked and also has incorrect version.
Workaround: It is strongly recommended that you do not mix node-locked codewords and floating 
codewords in one license file nor in any configuration that ends up with node-locked codewords and 
floating codewords both available on the same server. In other words, put the node-locked license and 
the floating license on different servers, and point to the respective one based on what you need to 
run.
If a user simultaneously runs two instances of a product and has mixed different versions of the same 
codeword on one license server, extra licenses may be pulled and result in unexpected “Licensed 
number of users already reached for this feature” errors.
Workaround: We recommend you remove expired codewords, to separate out the new and the old 
versions of codewords into different files and different servers, and to point to the respective one 
based on what you need to run.
Not specifying the TCP/IP port for the license server during license setup may lead to unexpected 
behavior and/or license checkout failure on the Windows platform. We strongly recommend you to 
always explicitly specify the TCP/IP port associated with each license server.
A node-locked and floating bundle operating on Linux cannot be shared between products using EDA 
License Tools version older than 2014.01 when run at the same time.
License Setup Wizard does not remove any previous user-configured FLEX Windows License Service 
manually set up by a user using FlexNet's lmtools. 
Workaround: You must remove the previous user-configured Windows License Service via lmtools.

Run the lmtools.exe from C:\Program Files\Agilent\EEsof_License_Tools\bin to invoke the 
lmtools utility. The lmtools utility window is displayed.

If you have installed an EEsof product released before 1st August, 2014 on your system prior 
to installing an EEsof product released after 1st August, 2014 then the default EEsof 
Licensing tools path will remain C:\Program Files\Agilent\EEsof_License_Tools. On 
the systems that only have EEsof products released after 1st August, 2014 installed then the 
default EEsof Licensing tools path will be C:\Program 
Files\Keysight\EEsof_License_Tools.

https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
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In the Service/License File tab, check the Configuration using Services option. All user-configured 
FLEX Windows License Services will be listed.
Select the service you wish to remove.
Select the Config Services tab and click the Remove Service button to remove the service.
To ensure that the license service or lmgrd is running, click View Log. A log window appears that 
confirms whether agileesofd and lmgrd are up and running.

While running multiple versions of prior ADS releases together, set 
ADS_MAXIMUM_BUNDLE_USAGE=ON in your environment so that all of them will use the same 
method to check out licenses. Otherwise, you might receive an error message, "Licensed number of 
users already reached".
On some Windows 7 machines, when more than one definition of an Ethernet adapter exists 
(duplicates), license checkouts may appear to hang up.
Workaround: Disable the duplicate network card definitions in your network settings: Control Panel > 
Network and Internet > Network Connections. This issue has been acknowledged by Flexera and they 
have created a bug report (SIOC-000103097).
For LSF style distributed simulations, ensure that the PATH on the client computer points to the 
$HPEESOF_DIR/EEsof_License_Tools/${architecture} directory that corresponds to the EEsof release 
being used. This needs to be done in order to ensure that the proper version of the Flexera utilities 
(like lmutil ) gets picked up in the path before any older in-compatible versions (that may also be 
installed on a users’ system.)
License Setup Wizard ( aglmwizard.exe ), which is used to set up and record the license path would 
not work if you already have an environment variable set for ADS_LICENSE_FILE.
Workaround: You can use ADS_LICENSE_FILE variable to point to license file or refer to Licensing (For 
Administrators).
The License Setup Wizard will exit or not properly configure a license server, if the server has all of its 
licenses currently in use.
Workaround: Wait for a license on the server to become available as you normally would before 
launching the product.
Unable to set license in case unicode characters are used either in path or license file name because 
the Flex License Service does not support these characters.
The Product Selector tool will be unable to display the license server status properly when connected 
to older license server.
Workaround: Upgrade your license server to the latest version.
EEsof Licensing Tools installer can hang on systems with McAfee LiveSafe installed and running the 
default firewall settings.
Workaround:  Prior to installing EEsof Licensing Tools, temporarily turn off the McAfee LiveSafe 
firewall.
Licensing setup steps on systems with McAfee LiveSafe installed can fail.
Workaround:  Under the McAfee LiveSafe firewall settings, under Port and Settings, allow the use of 
port 27001 for lmgrd.exe under the EEsof Licensing Tools installation bin directory.  Under Internet 
Connections for Programs , enable lmgrd.exe, aglmmgr.exe and aglmwizard.exe for all devices and 
turn off monitoring.
On Windows, EEsof product releases prior to 2014 can have boot time issues with licensing if an 
newer EEsof product is installed prior to installing the older product. For example, if a users installs 
Advanced Design System 2017 and then installs Advanced Design systems 2014.01, the user can 
have boot time errors with ADS 2014.01.
Workaround:  For Advanced Design System users,  set a system environmental variable named 
ADS_LICENSE_FILE under the Control Panel/ System, and Security / System / Advanced system 
settings and under the "environmental variables".  Add an System variable named 
ADS_LICENESE_FILE and the value will be the path to your local license file or the port@host setting 
for your site.

https://edadocs.software.keysight.com/pages/viewpage.action?pageId=607055365
https://edadocs.software.keysight.com/pages/viewpage.action?pageId=607055365
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  Back to Feature Updates

Third Party Applications
Spyder application menu bar becomes inactive when the window is maximized using View > Full 
Screen or by pressing F11 (shortcut key to maximize the screen).
Workaround: Press F11 again to make it the default screen. The menu bar is now active and works 
fine.

  Back to Feature Updates

Virtual Test Bench

When using VTB on Virtual Machine (VM), if SystemVue crashes then ensure to restart your system.
To use VTB, ensure ADS is installed in a path that has only ASCII characters.

Backward compatibility
In ADS, the customized VTB can have a backward compatibility issue.
Workaround: To fix this issue, use one of the following methods:

Open and Save the custom VTB in SystemVue2020Update1. Now, you can use the custom VTB in 
ADS.
A built-in workspace conversion tool is provided in the installer. You can convert the custom 
workspace (.wsv) to the newer SystemVue version. Use the following steps to convert the 
workspaces:

Open Command Prompt in the Administrator mode.
Browse the location of the old workspace. For example, C:\ADS_VTB.
Run the following command parameter.

C:

\ADS_VTB><SystemVueVTB_Installation_Dir>\bin\WorkspaceConversionTo

olManaged.exe" VTB_Examples.wsv VTB_examples_new.wsv

Where, 
1. <SystemVueVTB_Installation_Dir> is the location where SystemVue VTB package is installed. 
For example, C:\Program Files\Keysight\SystemVueVTB2020Update1.
 2. VTB_Examples.wsv is old SystemVue file and VTB_examples_new.wsv is converted file.

The following successful message is displayed.
Created: VTB_example_new.wsv
You can now use the VTB_examples_new.wsv workspace in ADS.

  Back to Feature Updates
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Examples - Known Issues
Examples under <ADS Install Directory>\examples \Instrument_links folder are not getting opened on 
Linux where as they are opening fine on Windows.
Workaround: Rename the ‘Instrument_links’ folder to ‘Instrument_Links’, if you have write permission 
to the <ADS Install Location>\examples folder. In case you do not have the write permission 
then proceed with manual unarchive process (File > Unarchive from the ADS Main window) pointing 
to the Example workspace. 
Example search might not work and prompt you the "Database is locked" error when ADS installation 
is on NAS.
Workaround: Restart the nfslock service on client. In case the problem still persists, reboot the client 
to unlock the database.

Unable to compile Pin Diode Model using Visual Studio 2012 on Windows 7 64-bit platform.
Workaround: Delete the contents of the directory examples\RF_Microwave\UserCompiledModel_wrk\ U
serCompiledModel\lib.win32_64 before using UCMs.
An error occurs while running a custom VTB.
Workaround: Download and run a custom VTB from the following location: <ADS Install 
Location>\SystemVue\2016.08\win32_64\VTB.  

   Back to Feature

Documentation
On Windows, Printing directly from installed help generates non-readable output.
Workaround: Use PDF version of the document for printing purpose.
From ADS 2016.01 onwards, in ADS help when you open a page using the "Open a link in new tab" 
option the help does not open a page in a different tab by default. You need to set the preferences to 
open any link in a new tab.
To set the preferences:

From the ADS 20xx (or the installed version) Help, Click File > Edit > Preferences.
The Preferences Dialog box is displayed.
Select the Options tab.
Under Appearance, select the Show tabs for each individual page option.

This is a one-time setting for a particular release of a product.
Unable to open online help, any external link, or Embedded Survey link in Linux on Mozilla Firefox 
browser.
Workaround: Use Mozilla Firefox version 39 or above or keep the Mozilla Firefox window open and 
then try to open online help.
While using the installed ADS help, you may encounter issues like help not showing any content, it 
throws an error, it displays unexpected hierarchy in the Content tab, or it does not display any search 
results.
Workaround: Close the help, delete the contents of the following directory, and open the help again. 

On Windows:  C:\Users\<Windows_Login_ID>\AppData\Local\Keysight\Help
On Linux: $HOME/.local/share/Keysight/Help
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ADS installed help search does not support [] or {} or any other text using these combinations.
On Linux, Konqueror web-browser does not display the online help properly. It may not display help 
pages at all or may display them broken and with errors. 
Workaround: Use Mozilla Firefox to view the online help.

  Back to Feature Updates
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